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The information in this guide provides procedures for using the ISIS
Driver as well as descriptions of the features. The same features should
be available on the user interface of the scanning application you are
using.

This guide describes the default ISIS Driver interface. Your application
may change the ISIS Driver user interface to better suit its purpose. If
your application provider has customized the ISIS Driver interface, it
may not match the default screen configurations as described in this
guide.
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Starting the SVT
Diagnostics/Scan
Validation Tool

1. Select Start>Programs>Kodak>Document Imaging>SVT

Diagnostics.

- Scan Validation Tool

Diriver Topes:
Tt

s |

Dirivers:
F.ODAK 15200
k.ODaK, 5600
k.ODAK, 5800
k.ODAK, 5850

. Select ISIS for the Driver Type and the KODAK 5200 (15600,

i5800, i5850) as the driver and click OK.

. Click the one of the Image Display mode buttons to enable the

image preview panels.

[T —— T — T — W —

4[]
) &
. Click the Setup icon on the main Scan Validation Tool screen.

" Scan Validation Tool - KODAK 3850 (ISIS) [E=EER
SO Q@O |y |&| 8D Dmm o
Dave Images To Files Display Every: 1

Total: Last File:

NOTE: For a description of the icons on this screen, see the next
section, “Scan Validation Tool dialog box".

The Setup dialog box will be displayed.

Compression

Frant Colar:

Front Bitonal:

Fear Color:

Fear Bitonal:

Group-4
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5. Click ISIS. The Preset Configurations dialog box will be displayed.
This dialog box maintains a list of saved driver settings.

You can save, delete or import a preset; or select a preset that is
already set up or one you want to modify.

r

KODAKi5200 0n Nene il il i e o

Prezet Configurations
%

Frezet Mame

Default

Black and‘white Perfect Page Document
Color Perfect Page Document
Multistream Perfect Page Daocumeant

Drescription
Diefalt zettings.

Properties

Image. .. ] [ Scanner... ]

Cancel ]

6. Click Image to configure settings associated with the image.

The following sections provide descriptions and procedures for
configuring Image settings. See the section later in this chapter

entitled, “Configuring Scanner settings” for scanner configuration
procedures.
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The Scan Validation
Tool dialog box

The Scan Validation Tool (SVT) is a diagnostic application provided by
Kodak. The SVT user interface allows access to all the features of the
scanner and is a good way to verify that the scanner is working
properly. The Scan Validation Tool allows you to verify scanner
functionality using the ISIS Driver.

Scan Validation Tool - KODAK 13850 (ISIS) =NREn X

"‘?:%' vu7‘-’“‘u:l‘ﬁ‘1ﬁ 0

Save Images To Files Dizplay Every: 1

Total: Last File:

Toolbar buttons

> Setup — displays the user interface for the selected driver.

Destination — allows you to select a directory to store scanned
— images and their file names. This option is only available when
Save Images to Files is selected.

> Start Scanning — scans the documents in the input elevator.
a1 Scan One Page — scans only one page.

W Stop Scanning — ends the scan session.

ﬁ License Key — displays the License Key window.

No Image Display mode — closes the Image Viewer window
(no images will be displayed).

‘]: One Image Display mode — displays one image at a time.

Two Image Display mode — displays two images at a time.

L
-

Four Image Display mode — displays four images at a time.
Eight Image Display mode — displays eight images at a time.

0 About — displays the version of the Scan Validation Tool.
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Save Images to Files — when selected, will save the images to the
specified directory.

Display Every — enter the sampling rate of the images you want to
display while scanning. For example, to see every image, enter a value
of 1. To see every 10t image, enter a value of 10.

Total — displays the total number of images scanned during the
current Scan Validation Tool session.

» To access the ISIS Driver (or TWAIN Datasource), double-click the
Setup icon on the Scan Validation Tool dialog box to access the
main Scanner window.

Last File — displays the full path and file name for the last stored
image.
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Configuring Image The main ISIS Driver window provides a set of default tabs for

settings configuring images. You can select each of these tabs and make any
choices necessary to meet your scanning needs.

This section describes the ISIS Driver default interface (as it is
presented through the Scan Validation Tool). Your host application may

modify the interface by not displaying some tabs or limiting the options
presented.

NOTE: The Image Mode and Toggle Patch selections are available
with all of the Image tabs (e.g., Main, Layout, Image Processing,

etc.).
f§ n
Properties for KODAK i5200 on None ‘ [
| Preset: [Defaut]
Image Made Adjustments I Backaground I Image Edge Fill I Blank Image Detection | About |
Camera: Main | Layout I Image Processing I Auto Color Detect I Dropout |
Front Image #1 Dot per inch:
O Front Image #2 [200 v]
O Back Image #1 g —
O Back Image #2 ST
[leed To Transport v]
Mode: Binarization
Black and White [ iThresholding - ]
Gi I |
col?g',-sca c Threshold ||
Auto Detect Grayscale i
Auto Detect Color
[
1
LContrast
Toggle Patch: U 0 =
of hd 50 50
Copy | [ ok [ camcel |[ Hep |[ Defaut

Image Mode — select one of the camera options:

» Camera — the selections in the Camera box list the available sides
(front and back) of an image where you can define individual image
processing values. Options include: Front Image #1, Front Image
#2, Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings

independently. Some settings apply only to black and white images,
others apply to color/grayscale images.
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* Mode — select one of the following modes:

- Black and White: if you want your electronic image to represent
all elements of your document in black and white.

- Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

- Color: if you want your electronic image to be in color.

- Auto Detect Grayscale: sets auto color detect for grayscale. See
the section entitled, “Auto Color Detect tab” for more information.

- Auto Detect Color: sets auto color detect for color. See the
section entitled, “Auto Color Detect tab” for more information.
Toggle Patch — indicates you want to tell the scanner, via a toggle
patch document, if the document is color/grayscale or black and white.
» Off: no patches will be used.

» Same Side: only the side which recognizes the patch sheet will
toggle.

» Both Sides: a patch will be recognized on either the front or the back
side.
Buttons — the buttons on the bottom of the window apply to all tabs:

» Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up
Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #1.

» OK — saves the values set on all tabs.
» Cancel — closes the window without saving any changes.

» Help — displays on-line help about the options available on the
selected window.

» Default — resets the values on all tabs to the factory defaults.
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Main tab The Main tab provides the following options:

f§ n
Properties for KODAK 5200 on None _ i (o]
Preset: [Defaut]

Image Made Adjustments I Background I Image Edge Fill I Blank Image Detection | About |
Camera: Main | Layout I Image Processing I Auto Color Detect I Dropout |
Front Image #1 Dot per inch:
O Front Image #2 [200 v]
O Back Image #1

Cropping:
O Back Image #2 AR

[leed To Transport v]

Mode: Binarization

(Thesholdng -]
Gi I
Corclg'rsca c Threshold L
Auto Detect Grayscale i

Auto Detect Color :

LContrast

Toagle Patch: U
Off -

50

L Conr | [ oK

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Select a resolution value from the drop-down list. The default is 200 dpi.
Available resolutions are: 100, 150, 200, 240, 300, 400, 500 and
600 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for dual stream scanning, color/grayscale and black and white
cropping must be the same per side. Only one cropping option can be
assigned per image.

» Automatic: dynamically adjusts the cropping window for different
document sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Fixed to Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed to Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled, “Layout tab” later in this guide.
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* Relative to Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where a separate color/grayscale or black and white area to be
saved is desired. It is useful in applications where a photograph,
signature, embossment or seal appears in a consistent area for an
application (you may want that small area in color/grayscale and the
rest in black and white). To define a zone, select the Layout tab.

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

* Best - Intelligent QC: this performs the same analysis as
iThresholding with the additional benefit of Intelligent QC (Quality
Control). For challenging documents the grayscale version of the
document is produced, allowing you final control over image quality
within your application software.

NOTE: This option is only available with Kodak Capture Pro
Software. Refer to the software’s documentation for more
information.

» iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (e.g., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents. If Fixed Processing is selected, only Brightness
can be adjusted.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (e.g., text, graphics, lines, etc.) from the
background information e.g., white or non-white paper background).
When using Adaptive Thresholding, Brightness and Contrast can be
adjusted. Use this option when scanning similar type documents.
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Threshold (Brightness) — this option is available when you select
Fixed Processing or Adaptive Thresholding (ATP). This option
allows you to change the black and white image to be darker or lighter.
The higher the threshold value, the darker the image. Use the slider to
select a value from 0 to 255. The default is 9.

Contrast — adjusts how much of the faint detail you want to see in the
output image. The higher the contrast value, the more faint lines will be
shown in the image. The lower the contrast value, the clearer (or less
detailed) the output image will be. If contrast is set too high, you may
get lines or black areas in your output image that you do not want. If the
contrast is set too low, some letters or lines may not show in the output
image. Select a contrast value from -50 to 50. The default is 50.

10
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Layout tab The Layout tab provides the following options:

Properties for KODAK 5200 onm . -
Preset: [Defautt]
Image Mods Adjustments Background I Image Edge Fil I Blank Image Detection | About |
Camera: m Layout | Image Processing I Auto Color Detect I Dropout |
Fo g Page Size:
O Front Image #2 IL R I
O Back Image #1 gliered onlln, T

O Back Image #2 Image Orientation
@ Portrait
Mode: ) Landscape
Grayscale [ | Automatic
Calor =

Auto Detect Grayscale
Auto Detect Color

Page Orientation

@ )
Toagle Patch: @ Top edge first

o - _) Battom edge first

) Left edge first
_ Right edge first

I Scan frea... I

[ oy | [ ok [ cancel ][ Hep |[ Defaut |

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down
list. Page size should be set to the Scanner’s maximum when using
the Automatic, Aggressive or Photo cropping option.

Image Orientation

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

» Automatic — the scanner will analyze each document to determine
how it was fed and will rotate the image to the proper orientation.

- Automatic - default to 90: the scanner will analyze the content
of each document to determine how it was fed and will rotate the
image to the proper orientation. If the scanner cannot determine
how the document was fed, it will rotate the image 90 degrees.

- Automatic - default 180: the scanner will analyze the content of
each document to determine how it was fed and will rotate the
image to the proper orientation. If the scanner cannot determine
how the document was fed, it will rotate the image 180 degrees.

- Automatic - default 270: the scanner will analyze the content of
each document to determine how it was fed and will rotate the
image to the proper orientation. If the scanner cannot determine
how the document was fed, it will rotate the image 270 degrees.
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Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
to Transport or Relative to Document. See the next section entitled,
“The Scan Area dialog box” for more information.

Scan Area dialog box The Scan Area dialog box allows you to define the amount of image
data which is returned to the host.

NOTE: Select the desired Camera Mode (e.g., Front Image #1, Front
Image #2, Back Image #1 and/or Back Image #2).

» Select Scan Area on the Layout tab to access the Scan Area dialog

box.
Properties for KODAK i5200 on Not _ﬂ [
| Preset: [Default]
Image Mode Adjustments Background I Image Edge Fill I Blank Image Detection I About |
-Came_m: Layout | Image Processing I Auto Color Detect I Dropout |
Frortt Image #1 Page Size:
O Frort Image #2 [L FYPET ]
[ Back Image #1 stter -85 11 in =
O Back Image #2 Image Orientation
@ Partrait
Mode: -
() Landzcape
Black and White
Grayscale [ | Autamatic
—_—

Calor
Auto Detect Grayscale
Auto Detect Color

FPage Orientation

Toagle Patch: 0 Top edge fI[St.
o - (") Bottom edge first
() Left edge first
() Right edge first
[ Scan frea... ]
H
Copy | [ ok ][ cancel |[ Hep |[ Defat

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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NOTE: The Scan Area dialog box is only available when Fixed to
Transport or Relative to Document is selected on the Main

tab.
Scan Area [i_&J
ize: 1] 1 2 3 4 5 B 7 8
Eege Siz: |.|.|.|.|.|.|\|.|.|.|.|l|.|.|.|.|.|
Letter - 8.5 % 11 in v| [0 3 Front )
Page Layout 3
@ Paortrait C T3
Landscape E
1 E
| 3
Area 4 3
| Snap 1
5 3
v K ]
v o £ 3
width: 81/2" 3
E
Height: 11" r
Units: 8 3
Inches | |
g
—
0 3
[ 0K ] | Cancel

Page Size — the default paper size is set when a scanner is first
selected. You can choose a different paper size using the drop-down
list.

NOTE: Page Size also appears on the Layout tab. If you make a
change on the Scan Area dialog box, the same selection
appears on the Layout tab and vice versa.

Page Layout

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

Area

* Snap — enable this option to control the dimensions of the preview
area to fixed 0.3175 cm (1/8-inch) increments. This option is not
available in Pixels mode.

» X: the distance from the left end of the scanner to the left-edge of the
scanning area.

* Y: the position from the top end of the document to the top end of the
scanning area.

» Width: the width of the scanning area.
» Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,
Inches or Centimeters.
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Image Processing tab The Image Processing tab provides the following options:

Properties for KODAK i5200 on None -1 =
| Preset: [Defautt][2]
Adjustments Background Image Edge Fill Blark Image Detection About
Image Mode
Camea: image Frocessing | Auto Color Detect | Dropout_|
Front Image #1 General Options
[ Frort Image #2 ;
[ Back Image #1 O
O Back Image 22 Halftore Remaoval
O invert Image it
Mode: Document Type
Black and White [Text with Graphics V] [
Grayscale I
Color Media Type
Auto Detect Grayscale -
HAuto Detect Color [Thm Paper ']
(
Eietter |
Muoise Filter
e [Lone Fixel -
Off -
Streak Filker
On U 0
2 2
i
Copy | [ ok

————

General Options

» Deskew — automatically straightens a document within £0.3
degrees of the leading edge of the document. Deskew can detect up
to a 45-degree skew and correct up to a 24-degree angle at 200 dpi
or a 10-degree skew angle at 300 dpi. This option is only available
when Automatic is selected.

NOTE: To prevent data loss, the document must have all four
corners within the image path.

» Halftone Removal — enhances images containing dot matrix text
and/or images with shaded or colored backgrounds using halftone
screens and effectively eliminates noise caused by the halftone
screen.

» Invert Image — allows you to select how the black pixels will be
stored in the image. By default the black pixels are stored as black
and the white pixels are stored as white. Turn this option on if you
want the black pixels stored as white and the white pixels stored as
black.

NOTE: You may want to change this option if your application
misinterprets the image data and stores your image in
reverse of what you expect.

* Add Border — allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image. This option is not available
when Aggressive is selected.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Hole Fill — allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g., double-punched or those
having a slight tear that could have occurred when the document was
removed from a binder).

» Do not turn Hole Fill on if you are scanning photos.
Document Type
» Text: when the documents you want to scan contain mostly text.

» Text with Graphics: when the documents you want to scan contain
a mix of text, business graphics (bar graphs, pie charts, etc.) and line
art.

» Text with Photographs: when the documents you want to scan
contain a mix of text and photos.

» Photographs: when the documents you want to scan are comprised
mainly of photos.

Media Type — allows you to select the type of paper you are scanning,
based upon the texture/weight. The options are: Plain Paper, Thin
Paper, Glossy Paper, Card Stock and Magazine.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

» Draft: maximum compression which produces the smallest image
size.

» Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

» Superior: the least amount of compression which produces the
largest image size.

Noise Filter
* None

» Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

* Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vice versa.

Streak Filter — allows you to configure the scanner to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.g., dirt, dust or frayed
edges) or by not following the recommended cleaning procedures for
your scanner. Adjust the extent at which the streaks are filtered by
moving the slider bar from -2 to 2. The default is 0.
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Auto Color Detect tab The Auto Color Detect tab provides the following options:

Properties for KODAK i5200 cm e =5
Preset: [Defautt][2]

Image Mode | Adjustments I Background I Image Edge Fill Blank Image Detection About
Camem: | Main | Layout | ImageProcessing | Auto Color Detect

Front Image #1 Color Content

O Front Image H#2
[ Back Image #1

[ Cuistam - ]

[ Back Image #2 Colar Amount Color Threshold
U 2 [ 0=
Mode:
= 1 200
Black and White 0 0
Grayscale
Colar Learn
Auto Detect Grayscale

Uze the learn mode to determine the proper -
Color Amount for detecting your color

documents. Set the Colar Threshold value

and click the Learn button to begin

Auto Detect Color

Amount Detected: 0

Threshold Detected: 0

Copy oK [ cancel |[ Hep | [ Defout

Color Content
« Off: this is the default. No color content will be detected.

» Low: documents requiring only a small amount of color to be saved
as color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

* Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

» High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.
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» Custom: allows you to manually adjust the Color Amount and/or
Color Threshold.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select Custom option to manually adjust Color
Amount and/or Color Threshold.

Color Amount: the amount of color that needs to be presentin a
document before it will be saved as either color or grayscale. As the
value of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

Color Threshold: the color threshold or intensity (i.e., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required. Valid values are 0 to 100.

Learn — allows you to calculate your settings based on representative
color documents scanned. Before selecting Learn, place at least 5
representative color documents in the input elevator. The documents
will be scanned and analyzed to determine the recommended Color
Amount.

NOTE: The Color Amount and Color Threshold sliders will be
updated automatically. If these values do not provide the
desired results with your job set, you may need to manually
adjust the Color Threshold.
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Dropout tab The Dropout tab provides the following options:

Properties for KODAK 5200 on Nort s B =5
Preset: [Default][2]
Image Mode | Adjustments I Background I Image Edge Fill I Blank Image Detection | About |
7Came_m Main I Layout I Image Processing I Auto Color Detect | Dropout
Fam TErE Color Dropout
Front Image #2 Color
[ Back Image #1 {Nnne ,]
[ Back Image #2
Mode:
Black and White
Color
Auto Detect Grayscale
Auto Detect Color
Off
[ copy | [ ok [ cancel |[ Hep |[ Defaut |

Color Dropout — used to eliminate a form's background so that only
the entered data is included in the electronic image (i.e., remove the
form’s lines and boxes). For black and white images, these settings
effect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

» Color: select the desired dropout color.
- None

- Multiple: drops colors other than dark shades (e.qg., black or dark
blue ink). This feature will do a color analysis of every image
scanned and will drop out up to 5 different colors. The individual
color can be any color of more than 16 million colors. Use the
Aggressiveness slider to adjust the color. This feature is unique in
that it looks at every page that is scanned. You do not need to
pick which color(s) to drop. Multiple is available for grayscale
output.

- Predominate: drops the predominant color. Use this option even
if your forms are all the same color, as it drops a wider range of
single colors. This option is also a good choice if you have
several forms that each have one form color as you can mix the
forms in a single batch.

- Red

- Green

- Blue

» Aggressiveness: allows you to adjust the extent at which colors are
dropped. The values range from -10 to 10. The default is 0. This
option is only available when Color is set to Multiple or
Predominant.
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NOTES:

 All Color Dropout options are available when the Scan as selection is
Black and White.

* Red, Green and Blue are available for grayscale scanning.

» Color dropout is not available for color scanning.

The following red, green and blue Pantone values should provide good
dropout performance.

These values were established by using the standard Pantone
Matching System® Colors guide (uncoated, 175-line screen). If the
background of the document you are using is not bright white, the
results may vary. iThresholding is recommended. If iThresholding does
not provide acceptable color dropout results, the ATP conversion
guality setting will provide more control for binarization.

The following is a list of colors which may be used with the red, green
and blue dropout options.

RGB Electronic Color Dropout for i5000 Series Scanners,
Firmware V3.09.01

Red Dropout

144U 150U 151U 1485U 1495U 1505U Orange 156U
021U
157U 158U 1555U 1565U 1575U 1585U 162U 163U
164U 165U 1625U 1635U 1645U 1655U 169U 170U
171U 172U 176U 177U 178U Warm Red 179U 1765U
U
1775U 1785U 1788U 1767V 1777U 1787U Red 032U 182U
183U 184U 185U 186U 189U 190U 191U 192U
1895U 1905U 1915U 1925U 196U 197U 198U 199U
200U 203U 204U 205U 206U 210U 211U 212U
213U 217U 218U 219U Rubine Red 223U 224U 225U
U
226U 230U 231U 232U |Rhodamine| 236U 237U 238U
Red U
239U 240U 2365U 2375U 2385U 2395U 2405U 243U
244U 245U 246U 247U 250U 251U 252U Purple U
253U 256U 257U 2562U 2572U 2582U 2563U 2573U
2567U 263U 264U 2635U 2645U 236U 2365U 2375U
243U 244U 245U 250U 251U 256U 257U 2562U
2572U 2582U 2563U 2567U 263U 264U 2635U 2645U
1375U
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Green Dropout

106U 107U 108U 109U 113U 114U 115U 120U
121U 122U 1205U 1215U 127U 134U 135U 1345U
148U 317U 3245U 331U 332U 333U 337U 3375U
3385U 3395U 344U 345U 351U 352U 353U 358U
359U 360U 365U 366U 367U 368U 372U 373U
374U 375U 376U 379U 380U 381U 382U 386U
387U 388U 389U 390U 393U 394U 395U 396U
397U 3935U 3945U 3955U 3965U 317U 3294U
Blue Dropout
317U 3245U 236U 2365U 2375U 243U 244U 245U
250U 251U 256U 257U 2562U 2572V 2582U 2563U
2567U 263U 264U 2635U 2645U 236U 2365U 2375U
243U 244U 245U 250U 251U 256U 257U 2562U
2572U 2582U 2563U 2567U 263U 264U 265U 266U
2635U 2645U 2655U 270U 271U 272U 2705U 2715U
2725U 2706U 2716U 2726U 2707U 2717V 2727V 2708U
2718U 2728U 277U 278U 279U 283U 284U 285U
290U 291U 292U 293U 2905U 2915U 2925U 2935U
297U 298U 299U 300U 2975U 2985U 2995U 3005U
304U 305U 306U Process 310U 311U 312U 313U
Blue U

3105U 3115U 3125U 317U 318U 319U 324U 3242U
3252U 3245U
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Adjustments tab The Adjustments tab provides the following options:

r ~
Properties for KODAK i3600 on STI - 0008 |
Presst: My Presets[2]
Image Mods Main I Layout I Image Processing I Auto Color Detect I Dropout |
Camera: Adjustmerts | Background | Image Edge Fill | Blank Image Detection I About |
Front Image #1 Brightnesz and Contrast
O Frort Image #2 lA pe— I
O Back Image #1 uiomalie
O Back Image #2
Calor Balance
L lAutnmatic v]
Black and White
Grayscale
Auto Detect Grayscale Sharpen
Auto Detect Color INormaI ']
Toagle Patch:
Off -
[ coy | [ ok ][ cemcel |[ Hep ][ Defaut

Brightness and Contrast

* None
« Automatic: automatically adjusts each image.
» Manual: allows you to set specific values that will be used for all
images.
- Brightness — changes the amount of white in the color or
grayscale image. The values range from -50 to 50. Default is 0.

- Contrast — makes the image sharper or softer. The values
range from -50 to 50. The default is 0.

Color Balance (not available for grayscale images).

* None
» Automatic: adjusts the white background of each document to pure
white. This option compensates for the variations that occur between
different weights and brands of paper. This is not recommended for
use with Photographs.
* Automatic - advanced: for advanced users that want to further
adjust the Automatic option.
* Manual: allows you to set specific values that will be used for all
images.
- Red — changes the amount of red in the color image.The values
range from -50 to 50. The default is 0.
- Green — changes the amount of green in the color image. The
values range from -50 to 50. The default is 0.
- Blue — changes the amount of blue in the color image. The
values range from -50 to 50. The default is 0.

Sharpen — increases the contrast of edges within the document.
Options are: Normal, High and Exaggerated.
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Background tab The Background tab provide the following options:

Properties for KODAK i5200 on Not ‘ﬁ - |
Presst: [Default)2]
Image Mode Main ayout | Image Processing I Auto Color Detect I Dropout |
Camera: H Background | Image Edge Fill I Blank Image Detection I About |
B ackground Smaoathing
o Br:;t( l:;iz # [Change ta Wwhite ']

O Back Image 22 Apply to: [Predominant v]

Aggressiveness: U n =

Mode:
Black and White 10 10

Calor
Auto Detect Grayscale
Auto Detect Color

[ Coy | [ ok [ camcel |[ Hep |[ Defautt |

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color.

* None: no background smoothing will be performed.
» Automatic: smooths up to three background colors.

« Automatic - advanced: for advanced users that want to further
adjust the Automatic option.

- Aggressiveness - allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10.

» Change to White: identifies up to three background colors and
substitutes each color with white.

- Apply to:
* Predominant - smooths the predominant background color to
white.

* Neutral - smooths only the neutral color to white, and also
smooths up to two additional background colors.

 All - smooths the neutral color and up to two additional
background colors to white.

- Aggressiveness: allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10.
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Image Edge Fill tab The Image Edge Fill tab provides the following options:

Properties for KODAK i5600 on STI - 0008 =

Preset: My Presets[Z]

Image Mode | Main I Layout I Image Processing | Auto Color Detect I Dropout |
-Came_la: | Adjustments I Backaround | Image Edge Fill | Blank Image Detection I About |

Front Image #1 Image Edge Fill
O Front Image #2 Fill Calar:
O Back Image #1
lNone v]

O Back Image #2

FErame Mode

Mode: 0.00in

Black and White
Grayscale 0.00 in

Auto Detect Grayscale 0.00 in
Auto Detect Color

0.00in

Toggle Patch:
Off -

[ Copy | [ ok ][ cancel |[ Hep |[ Defaut |

Image Edge Fill — fills the edges of the final electronic image by
covering the area with the specified color.

* Fill Color:

- None

- Automatic: the scanner will automatically fill the edges of the image
using the surrounding color.

- Automatic - include tears: in addition to filling the edges, the
scanner will also fill in tears along the edge of document.

- White

- Black

Frame Mode — when you select either Black or White, you can enter
the size of the frame that you want to fill. An equal amount of the
selected color from the Image Edge Fill drop-down list will be filled in on
all sides of the image.

If Frame Mode is not selected, you can select a value in the Left,
Right, Top and/or Bottom area(s) from each side of the scanned
image to be filled with Black or White as selected.

NOTE: When using this option, be careful not to enter a value too large
as it could fill in image data that you want to keep.

1
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Blank Image Detection tab The Blank Image Detection tab provides the following options:..

— TRET I W W o -
Properties for KODAK {5200 on None 2 _ A (S
Preset [Defaul][2]
Image Mode | Main I Layout | Image Processing | Auto Calor Detect | Dropout |
-Came_la: | Adjustments I Background I Image Edge Fill | Blank Image Detection M
Frort lmage #1 Blank Image Detection
Front Image #2 Maode
O Back Image #1 ISize vI
O Back Image 22
[ Black and white
Mode 1EB
Black and White
ayscale [¥] Gragscale [l
Color
futo Detect Grayscale U 1KEB
Auto Detect Color
Colar I
U 1KE
1KB 1000 KB
Off
Leam Content
Use the leam mode to determine lmage content Amount.
Leamn
[ coy | [ ok J[ cancel |[ Hep |[ Defaut |
————

Blank Image Detection — allows you to configure the scanner to not
give blank images to the scanning application. Select the image size
(KB), below which an image is determined to be blank. Images with
sizes less than the number you select will not be created. If you use this
option, you must specify a blank image size for each image type (Black
and White, Grayscale and Color) you want to delete. If you do not
make an entry in these fields, all images are kept.

» Off: all images are given to the scanning application.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied).

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

NOTE: Blank Image Detection by Content has been improved in
Scanner Firmware 3.12.1 (and higher) to allow better
detection of pages with very little text. The improved feature
can determine differences between just a few characters on a
page. Because the feature is more sensitive, you may need
to increase the value for percentage content if you find that
images are being deleted that you do not want to delete. For
example, a setting of 5% would equate to 12-13% with the
improved feature.
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Learn Content — allows the scanner to determine the content amount
based on the documents to be scanned. Click Learn to use this
function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.

About tab The About tab displays information about your scanner and driver.
i - - - —
Properties for KODAK 15200 on None . ™ . M
| Fe==E [Defaut][2]
Image Mode | Main I Layout I Image Processing I Auto Color Detect I Dropout
-Came_m: Adjustments I Background I Image Edge Fill I Blank Image Detection | About
bkl This diver was wittan tohg K200 Version 2.0.11405.15001
Front Image #2 compatible with 1515 [R] but KODAK 15000 Series Scanner
[ Back Image #1 has not been certified by EMC ® 2014 EMC Corporation. Al rights reserved.
O Back Image #2 Carporation. QuickDriver Version 2.0.11311.21002
Mode: Device Information:
Black and White
Grayscale
Calor
Auto Detect Grayscale
Auto Detect Color
EMC, Captiva and 1515 are either registered trademarks or trademarks of EMC
Corporation in the United States and/or other countries. QuickDriver iz a trademark,

of EMC Corporation. All other trademarks used herein are the property of their
Toggle Patch: respective owners.
o - @ Copyright 2014 EMC Corporation. Al rights reserved.

Wisit Kiodak on the web:
Contact support

Product updates and documentation
Scanner product information

Copy | [ ok ][ cancel |[ Hep |[ Defaut
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Configuring Scanner  To access scanner settings from the ISIS Driver, go into the Scan

settings Validation tool as described earlier in this guide and access the ISIS
driver.
["koDAK 5200 on None g S ML o (|

Preset Configurations
x

Freszet Mame

Default

Black and *hite Perfect Page Document
Color Perfect Page Document
tultistream Perfect Page Document

Description

Drefault settings.

Properties

Image... ] [ Scanner...

» Click Scanner to configure settings associated with the scanner. The
following sections provide descriptions and procedures for
configuring Scanner settings. See the section entitled, “Configuring
Image settings” earlier in this guide for image configuration
procedures.
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Scanner tab The Scanner tab provides the following options:

Properties for KODAK 5850 on ST1 - 0003 ==

Preset: Matt Test[2]

Scanner | Multfeed Detection | Imprinter | Image Address | Patch / Batch | Stacking | Log | About
Document Feeder
Paper Source:
ADF
Feeder Pozition
500 Sheets -

Automatically start ransport

Sheet Counter 4
Timeout

7] 0n

{J 5 z
1 120 seconds

Response:

Pause Scanning - |
White Background ‘ Mone - ‘

Stacker;

b aximum Length: 17
Pawer Sayer. ‘ 240 = ‘
Inteligent Protection: ‘ Marmnal - ‘
[ Ok ] | Cancel | ‘ Help | | Default

Document Feeder

Paper Source — ADF (automatic document feeder). All documents will
be scanned from the input elevator.

Feeder Position — select one of the following input elevator positions:

* Normal: the input elevator is the highest position. This position is
recommended when you are scanning 25 sheets or less from the
input elevator.

* 100 Sheets — this selection is recommended when you are
scanning between 25 and 100 sheets from the input elevator.

» 250 Sheets — this selection is recommended when you are
scanning between 100 and 250 sheets from the input elevator.

* 500 Sheets — this selection is recommended when you are
scanning between 250 and 500 sheets from the input elevator.

» 750 Sheets — this selection is recommended when you are
scanning between 500 and 750 sheets from the input elevator.

Automatically start transport — if checked, the scanner will
automatically start scanning in there is paper in the input elevator. If no
paper is in the input elevator, an error will occur.

If this option is not checked, the scanner will go into a paused mode
and the operator can press the Go button on the Operator Control
Panel to start scanning.
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Sheet Counter — enter the number to be assigned to the next physical
sheet of paper entering the scanner. This is incremented sequentially
by the scanner and is returned in the image header.

Timeout — allows you to set the amount of time the scanner will wait
after the last document enters the transport before the transport timeout
action is taken.

Response — indicates the action that will be taken when the document
feeder timeout has been reached.

» Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job).

» Pause Scanning: scanning will stop but the scanning application will
be waiting for additional images (i.e., stops the feeder). Scanning
may be resumed by pressing the Start/Resume button on the
scanner. Scanning may be stopped by pressing the Stop/Pause
button on the scanner or via the scanning application.

White background — when turned on, indicates which side(s) of the
document will see White instead of Black where there is no paper.

» None: uses the Black background for the front and back sides.

» Front: only uses the White background for the front side, the back
side will use Black.

» Back: only uses the White background for the back side, the front
side will use Black.

» Both: uses the White background for the front and back sides.
The following are examples of when white background is used:

» Scanning non-rectangular documents and, in the final image, you
want the area outside the document to be White instead of Black.

» Scanning lightweight or thin paper, with printing on one side, and you
do not want the black background to bleed through the document and
appear in the final image.

NOTE: If you are using the i5850 Scanner, the only option available is
Both.

Stacker — allows you to select how the scanner transports documents
through the scanner. This affects how the documents are fed into the
scanner, how fast they move through the scanner, and how they are
placed in the output tray.

NOTE: When Controlled Dual Stacking is enabled, Document Handling
will automatically be set to a custom level with a throughput that
will be less than Best Stacking.

* Normal: no additional handling is performed. Best used when all
documents are similar in size.

- Full throughput
- Controlled stacking Off
- Minimum gap between documents
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» Improved Stacking: aids in controlling how the documents are
stacked/ordered in the output tray for mixed document sets. This
should work for the majority of mixed sets.

- Possible slight reduction in throughput
- Controlled stacking On
- Minimum gap between documents

» Best Stacking: when your document set contains a great variability
in size, this option provides the best control of how the documents
are stacked/ordered within the output tray.

- Slight reduction in throughput
- Controlled stacking On
- Large interdocument gap

» Fragile: for documents that need extra care as they are transported
through the scanner and placed in the output tray.

- Greatly reduced throughput
- Controlled stacking Off
- Minimum interdocument gap
- One-quarter transport speed
» Thick: for documents that are thicker than card stock
(120 Ib. / 0.25 mm).
- Greatly reduced throughput
- Controlled stacking On
- Minimum interdocument gap
- One-quarter transport speed

Maximum Length — select a value that indicates the length of the
longest document in your document set.

NOTES:

» Not all combinations of settings are supported at the larger lengths
(i.e, resolution, color, grayscale, etc.). For greater flexibility, the
scanner will not generate an error until it sees a document whose
length is not supported.

» The scanner’s throughput may be reduced for larger lengths.

 If a document that is longer than this value is scanned, the transport
will stop (leaving the document in the scanner) and a document jam
message will be displayed.
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» The Maximum Length will always range from 2.5 to 180 inches but
the true maximum length of the scan will depend on the bit depth
(color/grayscale/black and white and the resolution used for the
scan). Black and white 200 dpi will be 180 inches, but color 600 dpi
will be much less. If the scanner’s processing capacity is exceeded
before the user-selected Maximum Length is reached, then a
document jam will be posted on the scanner and the image of the
page will not be sent to the host application.

 If scanning a stack of mixed documents, where some documents are
very long, the best option may be to select when to enable Long
Document scanning by using either the Single Document override or
Batch override option from the scanner touchscreen.

» When Controlled Dual Stacking is enabled, the default setting will be
limited to the maximum length of 10 inches/254 mm. See Chapter 5,
“Length Protection Enabled” in the User’s Guide for more
information.

Power Saver — allows you to set the amount of time the scanner (1 to
240 minutes) will remain inactive before the scanner goes into an idle
state. The default is 15 minutes.

Intelligent Protection — allows you to select how aggressively the
scanner detects documents that enter the scanner incorrectly. This can
occur when documents are not prepared properly for scanning (e.g.
stapled or paper clipped documents).

* None

* Normal: this is the recommended option as it provides a balance
between minimizing document damage and stopping the scanner
unnecessarily.

* Minimum: select this option if the scanner is stopping too frequently
on documents that you do not want it to detect.

NOTE: Documents may become more damaged before detection
occurs.
* Maximum: select this option to get the least amount of document
damage.

NOTE: This may cause the scanner to stop unnecessatrily.
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Multifeed Detection tab Multifeed detection aids in document processing by detecting
documents that may go through the feeder overlapped. Multifeed can
happen due to stapled documents, adhesives on documents or
electrostatically charged documents. The Multifeed Detection tab
provides the following options:

Properties for KODAK 5850 on ST - 0003 (=3

Preset Matt Test[2]

Scanner | Mulifeed Detection | [mprinter | Image Address | Patch / Batch | Stacking | Log | About

Ultragonic Detection

Sengitivity: tedium v
Sensors
Left Carter Right
Qff: @ )
Ort C) C) @
On - Ignare:

1.000n

Length Detection

¥|0n Calibrate...
17.000n Auta Set
Action When Detected
Pauze Scanning v
Play sound on PC
C:\windows\mediahding. way 4
[ ok ] | Cancel | | Help | | Default |

Ultrasonic Detection — check this option to set multifeed detection.

» Sensitivity — controls how aggressively the scanner will work to
determine if more than one document is fed into the transport.
Multifeeds are triggered by detecting air gaps between documents.
This allows multifeed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: the least aggressive setting and is less likely to detect
labels, poor quality, thick or wrinkled documents as multifed
documents.

- Medium: use Medium sensitivity if your application has varying
document thickness or labels attached to the document.
Depending on the label material, most documents with labels
should not be detected as a multifed document.

- High: the most aggressive setting. This is a good setting to use if
all documents are similar in thickness to 75.2 g/m2 (20-lb.) Bond
paper.
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Sensors — five sensors cover the width of the paper path. In order for
multifed documents to be detected correctly, they must pass under one
of these sensors.

» Left through Right: these controls allow you to select which of the
five sensor(s) you want to have turned on. For example, if you know
that the left side of the document has a “sticky” note on it, you can
turn off the left sensor.

* Ignore up to: ignores a multifeed anywhere on the document that is
less than the value entered. This option is useful when you have a
known multifeed situation that you want to allow, but do not want to
have the sensor off for the entire document (e.g., 3-inch “sticky”
note).

NOTES:

- This option is available when at least one sensor is set to On -
Ignore.

- This length applies to all sensors set to On - Ighore.

Length Detection — when you enable Length Detection you can
select the maximum length of the document that can be scanned
without a multifeed being detected. Length detection is used when
scanning same-sized documents to check for overlap. For example, if
you are scanning A4 (8.5 x 11-inch) documents in portrait mode, enter a
value of 28.57 cm (11.25 inches) in the Maximum Length field. The
maximum value is 35.56 cm (13.99 inches).

» Auto Set: automatically sets the maximum length value t01.27 cm
(.50-inch) greater than the length of the currently selected page size.

Action When Detected — select what action you want the scanner to
take when a multifeed is detected. With all options, the condition will be
logged in the scanner.

» Continue Scanning: the scanner will continue to scan. The user-
configured multifeed sound will be made by the scanner.

» Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job). Verify that the paper path
has been cleared and restart the scan session from the scanning
application. The page will be ejected. The image of the multifed page
will not be sent to the host application.

» Stop Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) and
control will return to the scanning application (i.e., ends the job).
Clear any documents from the paper path prior to restarting the scan
session from the scanning application. The multifed image will not be
sent to the host application.
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» Pause Scanning: scanning will stop but the scanning application will
be waiting for additional images (i.e., stops the feeder). Scanning
may be resumed by pressing the Start/Resume button on the
scanner. Scanning may be stopped by pressing the Stop/Pause.

This option allows you to inspect a preview image of the scanned
page and choose to Accept the scanned image or Rescan the page
and discard the image from the scan that triggered a multifeed alarm.
The scanned images will not be sent to the host application until
accepted. This option allows all multifeed events to be handled at the
scanner. No image manipulation is required in the scanning
application. This option also allows you to stay in front of the scanner
reducing wasted movement and fatigue. This option is provided by
the scanner. No changes to the scanning application are
required.

NOTE: This option will automatically be enabled when the Pause
Scanning multifeed action is used if the scanner firmware is
Version 3.9.1 or higher.

The preview image will be oriented per the image processing
settings that were selected within the ISIS Driver (Automatic
Rotation). If the scanning application is rotating the image or
performing other image processing, the preview image will not have
scanning image processing applied.

 If scanning in duplex (front and back), then both images will be
displayed.

» If scanning in black and white, a black and white image will be
displayed.

« If scanning in color/grayscale, a color/grayscale image will be
displayed.

» If scanning in dual stream, a color/grayscale image will be
displayed.

« If scanning in black and white using VRS software, a grayscale
image will be displayed.
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Accepting the images: if you want to accept the image, touch
Accept on the Operator Control Panel or press the Start/Resume
button on the scanner. When Accept is selected, the images shown
in the scanner’s preview will immediately be sent to the scanning
application and scanning will continue.

Rescanning the page: if the page needs to be rescanned, remove
the top page(s) from the output tray and place the pages back in the
input tray (be sure to correct any document preparation issues).
When the pages are ready to rescan, touch Rescan on the Operator
Control Panel. The preview images will be discarded. If printing was
not enabled, the scanner will immediately start scanning. If printing
was enabled, the scanner will go to the Paused screen where you
can choose to Omit Printing on the next page scanned. You can
then press the Start/Resume button on the scanner to continue
scanning.

» Pause Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) but the
scanning application will be waiting for additional images (i.e., stops
the feeder). Clear any documents from the paper path prior to
resuming the scan session. Scanning may be resumed by pressing
the Start/Resume button on the scanner. Scanning may be stopped
by pressing the Stop/Pause button on the scanner or via the
scanning application.

e Stop Scanning - generate image(s): scanning will stop and control
will return to the scanning application (i.e. ends the job). Image(s) of
the multifed document will be generated. Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

Play sound on PC — check this option if you want the scanner to
make a sound when a multifeed is detected. The user-configured
multifeed sound will be made by the scanner.

NOTE: Clicking the Speaker icon will display the Open dialog box
allowing you to select the desired tone (.wav file) for your sound.

Calibrate — displays the Calibration window allowing you to perform
an Image Chain or UDDS calibration.

NOTE: Frequent calibration is not necessary or recommended. Only
perform a calibration when instructed to do so by your support
personnel.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Imprinter tab

The Enhanced Printer operates at full scanner speed. The printer can
add a date, time, document sequential counter, and custom messages.

This tab will only be present if the optional Enhanced Printer Accessory

has been purchased and installed in the scanner.

The print string can be configured to include both literal (static)
information (e.g., information that stays the same for each document,
such as batch name or operator) and dynamic information (i.e.,
information that may change for each page scanned, such as the
document sequential counter). The capture software application
controls static fields; any information that the software allows you to
enter can be sent to the printer.

Properties for KODAK 15850 on STI - 0003

Preset: Matt Test[2]

V| 0n

Level:

Scanner | Mulifeed Detection | Imprinter | Image Address | Patch / Batch | Stacking | Log

All Levels

Format Template:

Top Margin:

=3

About

@ 025

Date Urits:

Format: Delimiter: Inches -

MMDDYYY < [Mone | Fot

Harmal -

Counter Botation

Field width: 9 = 90 Degress -
Format:

Display Leading Zeros - | H

Exarnple:

| oK || Cancel || Help || Default

On — check this to enable the printer.

NOTE: Printing may be overridden from the scanner’s touchscreen.
Level — select the level that you want to set up the print string for. You
can set up to 4 different print strings at a time. This option can be used
to prevent printing on patch sheets. For example, to prevent printing on

Patch 2 sheets you should configure a format template for Level 1 and
leave the Level 2 format template blank.

» All Levels: prints on all documents
» Level 1: prints only on Level 1 documents
* Level 2: prints only on Level 2 documents

* Level 3: prints only on Level 3 documents
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Format Template — the format template is used to build the print
string. The print string is what is printed on documents as they pass
through the transport. If using the front printer, the print string is printed
before the document is scanned, therefore, it is part of the image. If
using the rear printer (i5850 Scanner), the documents are printed after
scanning, therefore, the printing will not be on the image. The maximum
amount of characters for each print string is 40 characters (including
spaces).

You can use the following imprinter format variables when building the
format template.

%S or # = counter

%T = Time
%Y = Date
%% - “%1!

NOTE: Refer to the on-line ISIS help documentation for additional
formatting options for these variables.

The i5850 Scanner supports the following variables to enable printing in
the Indexing/Image Address fields:

%A = the first element of an image address (e.g., Fixed field)
%B = the second element of an image address (e.g., Level 1)
%C = the third element of an image address (e.g., Level 2)
%D = the fourth element of an image address (e.g., Level 3)

Date — if you want to add a date to the print string, select one of the
following formats:

* Format: MMDDYYYY, DDMMYYYY, or YYYYMMDD.

» Delimiter: select one of the following separators: Slash: /,
Dash: -, Dot: ., Space or none. For example: 08/24/2010,
08-24-2010, 08.24.2010 or 08 24 2010 or 08242010 (none).

Counter — if you want to add a Counter to the print string, you can
enter one of the following options:

e Field Width: used to control the width of the document counter.
Values range from 1 to 9.

* Format — allows you to configure the format of the counter when the
width of the value is less than the field width (the examples indicate a
field width of 3 and the counter at 4). Options are:

- Display Leading Zeros (default): “004”
- Suppress Leading Zeros: “4”
- Compress Leading Zeros: * 4

Top Margin — allows you to define the distance from the lead edge
before the print string begins. Enter the desired amount in the text box.

NOTE: Printing automatically stops 6.3 mm (1/4-inch) from the trailing
edge of the document even if the information has not been
completely printed.
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Units — select Inches, Centimeters or Pixels.

* Font — you can select what orientation you want your information to
be printed: Normal, Large and Bold.

> > »
0 0 v
O P O

Normal: 90° rotation Large: 90° rotation Bold: 90° rotation

- Rotation — while the characters are printed vertically (starting at
the lead edge of the document) this allows you to select the
orientation of the print string. Available options are: 0, 90, 180, 270.

Feed
Direction 0 a0 180 270

T

oay
ABC

Nm=

<o)
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Image Address tab - Indexing/Image addressing is used for document tracking, batch control
i5850 Scanner only and image management. The scanner will increment the indexes based
on how you set up the selections on this tab.

Properties for KODAK 5830 on STI - 0002

Preset: [Defaul]

| Scanner | Iultifeed Detection I Imprinter| Image Address | Patch / Batch I Stacking | Log | About |

[Z]an

Farrnat String

Image Address
Kodal . 000001.000000.000000

Fresets

[Eustom -
Couriters

Start Value Width Level To Follow Format Character
Levz 0 s [ L

[ Check, digit
Formnat
[Displa_l,l Leading Zeros -

[ akK ][ Cancel H Help ][ Diefault ]

The Kodak i5850 Scanner has an option that was previously not
available with scanners having image address capability. The i5850
Scanner allows the scanner driver to control whether the scanner has
Indexing enabled or not. When Indexing is set to None, the indexing

counters will not be displayed on the Operator Control Panel of the
scanner.

Indexing - Enabled Indexing - Not Enabled

Idle

e e

Clear Path

Lower Elevator

Show User Counter

Lower Elevator

Operator Log

NOTE: The Operator Control Panel will not change until the job is
started.

On — turns indexing on and makes the rest of the options on this tab
available.
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Format String — this text field allows you to structure your image
address. The format string in the sample screen above represents a
fixed field value of address and a 3 level image address.

Image Address — displays the starting image address. The values in
this field reflect information from the Format String area and the Start
Value field in the Counters area. Each field can have a maximum width
of 9 characters. The total image address cannot exceed 27 characters
(30 with 3 delimiters).

Presets — you can use the selections in the field to automatically fill in
the format string field. The options are:

» Custom: enter your desired values.
* None

* Level 3: Address%3L%2L%1L

* Level 2: Address%2L%1L

* Level 1: Address%1L

* Level 3 Offset: Address%3L%2L

» Level 2 Offset: Address%2L

You can have no fixed field or enter any fixed field value. The default
fixed field value is Address.

Counters — for each image address level enter a Start Value, Width
and make a Level to Follow Level selection.

» Start Value: the start value is reflected in the image address in the
field designed by the format string.

» Width: a value of 0 indicates that no image address level will be
used. Widths cannot exceed 9 characters.

* Level to Follow: these are the rules the scanner follows to set the
next image address level if there are no other inputs. For example,
patch sheet or end of batch processing. You will have to define a
level to follow level for each of the level fields you defined in your
image address.

NOTE: The total value of the Width column plus the number of
characters in all fixed fields cannot exceed 27 characters.

Check digit — when checked, a character will be appended to the
image address string. The check digit character will be determined from
the values of the characters in the image address string. For more
information, contact Technical Support.

Format — select the format of the image address string used by the
printer and how it is displayed on the touchscreen. The following
choices are available for printing the counter format.

» Display Leading Zeros format (e.g., 0009). This is the default.
e Suppress Leading Zeros format (e.g., 9)

» Compress Leading Zeros format (e.g., 9)
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Patch/Batch tab

The Batch/Patch tab provides batch and patch functionality. Batching is
the operation of counting pages or documents. The Patch tab provides
choices of what patch type to recognize. One or more patches can be
selected at a time

Properties for KODAK 5850 on STL- 0003 (=5
Freset: Matt Test[2]
| Scanner I Multifeed Detection I Imprinter I Image .ﬁ.ddress| Patch / Batch | Stacking | Log I About |
Batch Contral Patch Detection
On On
Pages Per Batch Image Address Patch Codes
1 2 -
Batch Level to Count O Level3 3
Mone | Transfer Patch s Level 2 m
Level 1 [ Transter Patch &s Level 3 i
Level 2
Lewvel 3 Feature Patch Codes
At Batch Start SEUkIi [T 3
Nore —— — O Feature Patch Type
Gobo Lewvel 1 [ Feature Patch Type B
GotoLevel 2
GotoLevel 3
Confirmation Tone
At Batch End
Patch Readers
Stop feeder and transpaort pE % % %
Begin a new batch
End of Job é é é é
QK. ] [ Cancel ] [ Help ] [ Diefault

Batch Control

On — turns batching on and makes the rest of the options for Batch
Control available.

Pages Per Batch — defines the number of documents to be counted
prior to performing the action to take when the count has been reached.

Batch Level to Count — sets the level to count. You can select None,
Level 1, Level 2 or Level 3. The level you choose to count must exist in
the image address template as defined on the Image Address tab.

At Batch Start — defines the level for the next document after the
count is reached. Options are: None, Go to Level 1, Go to Level 2,
and Go to Level 3.

At Batch End — defines the action to be taken after processing the last
document in the batch. You can select: None, Stop feeder and
transport, Begin a new batch or End of Job.
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Patch Detection

On — turns patch detection on and makes the rest of the options for
Patch Detection available.

Image Address Patch Codes — these patch types are used for image
addressing. When the Patch Reader detects a patch, it automatically
assigns a new image address to the new document. This eliminates the
task of trying to determine where one document stops and the next
starts when an operator is viewing electronic images. It provides a
hierarchical document structure and offers an auto-batching
alternative.You can select Level 2, Level 3, Transfer Patch - Level 2
or Patch T/ Transfer Patch - Level 3.

The Patch Reader controls document level changes by automatically
sensing a predefined patch code and changing the document level
accordingly.

Patch 2 — assigns a Level 2 to the current document

(Do not use these patches for
production - they are not to spec)

Patch 3 — assigns a Level 3 to the current document

(Do not use these patches for
production - they are not to spec)

Patch T/Transfer Patch — assigns a predetermined level to the next
document. Defined by selecting Level 2 or Level 3 in the Definition box.

(Do not use these patches for
production - they are not to spec)
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Feature Patch Codes — these patch types can be used by the host for
post-scan image control (they are not used for image addressing). For
example, use these patch types for changing between black and white
and color/grayscale imaging or workflow control.

Feature Patch Type 1

(Do not use these patches for
production - they are not to spec)

image addressing - disabled

Feature Patch Type 4

(Do not use these patches for production - they are not to spec)

Feature Patch Type 6

(Do not use these patches for
production - they are not to spec)

Confirmation Tone — the confirmation tone may be used to signal that
a patch has been recognized. The default is no confirmation tone.

Patch Readers — select the icon that corresponds to the physical
patch reader location in the scanner. Select one, two, three or four
patch readers.

PR 1 - indicates the left patch reader.
PR2 - indicates the left center patch reader.
PR3 - indicates the right center patch reader.

PR4 - indicates the right patch reader.

Patch Readers:

= 0 = 0
202 2N

I
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Stacking tab The Stacking tab allows you to set options for separating documents

into the two stacks of the Kodak Controlled Stacking Accessory output
tray.

NOTE: The Stacking tab is only available when the Kodak Controlled
Dual Stacking Accessory has been enabled for your scanner.

Properties for KODAK 5850 on ST1 - 0003 (=3

Preset: Matt Test[2]

Scanner | Mulifeed Detection | Imprirter | Image Address | Patch / Batch | Stacking | Log | About

V| 0n

Stack to put detected documents in:

e

Detect Based On

Patch Type

M
M:
M
4 and Togale
Me

Length

25 Inches

| Mulifeed

I 0K H Cancel H Help || Default |

On — turns stacking on and makes the rest of the options on this tab
available.

NOTE: Stacking also may be overridden to be On or Off from the
scanner’s touchscreen.

Stack to put detected documents in: indicates which stack
documents matching the Detect Based On settings will be placed in.
All non-matching documents will be placed in the other stack.

NOTE: Because document weight and condition can impact the ability
of documents to stack optimally, it is recommended that when
you separate documents less than 6 inches/152 mm (e.g.,
checks) you place them in Stack #1; and when separating
documents longer than 6 inches/152 mm (e.g., patch sheets)
you place them in Stack #2.
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Detect Based On

» Patch Type — allows you to select which patch sheets, if any, to
separate from the document set and place in the selected stack.
Options are any combination of: T, 1, 2, 3, 4 and Toggle and 6. Itis
recommended that the patch sheets go into Stack #2.

The Dual Stacking Toggle Patch option on the touchscreen allows
you to use patch sheets to separate a document(s) from the
documents being scanned into Stack #2 or Stack #1.

NOTES:
« The scanner will generate images for patch sheets.

« Printing the patch sheets on stiff paper will aid in reliable stacking.

» See the section entitled “Requirements for patch codes” in the
User’s Guide for more information.

Length — allows you to select which documents to separate from the
document set based on the document’s length.

» Off

» Less Than: documents shorter than this length will be separated and
placed in the selected stack. This is recommended when separating
shorter documents (e.g., checks) into Stack 1.

» Greater Than: documents longer than this length will be separated
and placed in the selected stack. This is recommended when
separating longer documents into Stack 2.

» Between: documents whose length falls within the selected range
will be separated and placed in the selected stack.
NOTES:

* When entering a length, consider including an extra 1/2 inch / 25
mm to account for possible document skew during scanning.

e For documents shorter than 6 inches / 152 mm, you may consider
using the Short Document Insert to improve stacking in Stack 1.

Multifeed — select this option if you want to separate all documents
that are determined to have been multifed. The settings to turn on and
configure multifeed detection are on the Device - Multifeed tab.

NOTES:

» This option can provide additional functionality by allowing you to
detect thicker documents and separate them into Stack #2. This is a
good choice to consider when Length based detection cannot be
used because all of the documents are a similar size.

» This option will not automatically turn on multifeed detection.
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Recommended Following are some examples of how to use the Stacking option.
configurations for using

the Stacking option Short document out-sorting

Short
document

Long
documents

If your goal is to sort checks or short

| Scanner | Mulifeed Detection | Imprinter | Stacking [Log |

o documents from your other documents,
SIack to put detected documents in: Conflgure the StaCkIng SettlngS as
follows:

Detect Based On
Paich Type Stack to put detected documents in:
1 (Stack #1)
Os and set the Length option to:
O 4 and Toagle
Os Less Than: the length of your shortest
document plus 1/2-inch.
el NOTES:
Less Than v]
45| Inches *You need to add an extra 1/2-inch to
: account for possible skew during
Ll b feeding short documents.

«If you attempt to stack the shorter
documents in Stack #2, they will not successfully reach the Stack #2
location.

» For documents shorter than 6 inches, you may consider using the
Short Document Insert to improve stacking in Stack #1.

1
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Patch code document separator out-sorting

Non-patch
documents

Patch
documents

If your goal is to sort document
separator sheets with patch codes (or
color toggle patch sheets) from your

| Scanner I Multfeed Detection I Impnrrter‘ Stacking | Log I A

[¥1an

Stack to put detected documents in:

other documents, configure the
Detect Based On Stacking settings as follows:
Patch Type
Stack to put detected documents in:
[
2 2 (Stack #2)
3
;a"d“gg'e and set the Detect Based On: Patch
Type option to one or more patch
types.
Length
|uffgt 7 Inserted patch documents used for
o document separation are normally

ordered in bulk or printed on demand.
For controlled dual stacking find a stiff
paper that works well with your job and
print the patch documents on this
paper; this aids with reliable sorting and stacking.

[ Multifeed
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Selected document out-sorting

Non-patch
documents

Patch
documents

If your goal is to out-sort a selected
| scare | Mutdead Dtecin | impnter| Sz [1os - documeent(s) from the stack (e.g.,

[@ln invoices that are over a $10,000),
Stack to put detected documents in . . .
configure the Stacking settings as
Detect Bazed On fO||OWS

Patch Type

Stack to put detected documents in:
2 (Stack #2)

gandwg'e and set the Detect Based On: Patch Type
option to one or more patch types.

- configure Dual Stacking Toggle Patch

[Tl -] on the touchscreen on the scanner to a

o patch type that is not specified for
document separation (e.g., Patch 6).

[ Multifeed

during document preparation, insert the
patch sheet in front of and behind the
document(s) you want to out-sort.

After scanning, the patch sheet and documents will be output to Stack
#2.
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Multifeed alarm document out-sorting

If your goal is to sort documents that
have triggered a multifeed alarm,
configure the Stacking settings as

aner I Muttifeed Detection I Imprirrterl Stacking | Log I A

[On

Stack to put detected documents in:

follows:
DBLZTLE?ZZ?“ Stack to put detected documents in:
M ———
2 (Stack #2)
2
M and set the Detect Based On: Multifeed
;and Toggle Optlon
Triggering exception stacking by
Lo multifeed can provide additional
oi ) functionality. For example, stacking
o Inches documents that trigger a multifeed alarm

in Stack #2 can be a way to sort thicker
documents that you cannot sort by size
or patch.

Multifeed

NOTE: The Allow Maximum Length override will not disable
Controlled Dual Stacking Length Protection.
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Logs tab The Logs tab provides a listing of any errors that have been

encountered.
Properties for KODAK 15350 on STI- 0003 ===
Preset Matt Test2]
Scanner | Multfeed Detection | Imprinter | Image Address | Patch / Batch | Stacking | Log | About
KODAK 15850 on STI - 0003 -
Hodel 15850 [
Printer: true 3
Background Front white
Background Rear: white
Connection TUSBSCAH-2 .0
Serial Humbsr 54832498
Firmware dll: 4.0.6
Driver.dll 2.18
Device.dll 3.8
DeviceManager . dll: 2.12
Heter Log
Heters Log
Power On Hours 24
Transport On Hours 0.
Front Lanp Hours 22
Rear Lamp Hours 22
Pages Scanned 24
Firet Sran Nate (Y
] n 3
| 0K ‘ | Cancel ‘ | Help ‘ ‘ Default ‘

You can view the Operator and Meter logs and save this information to
a file by clicking the Save icon, or copy the information to the clipboard
which can then be pasted into a document.

1
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